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Overview 

This tutorial is optimized for Echoview 11 and provides an introduction to Echoview.  

This tutorial is not intended as a comprehensive user manual.  

Further information on Echoview tools and topics can be found in the latest version of the Echoview help file. 
This can be viewed online and is installed with Echoview. Press F1 when using Echoview to open the help file 
and read context-sensitive information. 

Throughout this tutorial further reading is referred to the Echoview help file or other Echoview learning 
materials: https://www.echoview.com/technical-support 

Prerequisites 

This tutorial assumes you have Echoview installed, and the following skills and knowledge: 

• Familiarity with a supported Microsoft Windows™ operating system. For more information refer to the 
Echoview Help file page: Computer requirements.  

• A basic understanding of echosounding techniques and hydroacoustic surveying. For more information, 
see texts such as Fisheries Acoustics (Simmonds and MacLennan, 2008, Chapman and Hall, London). 

Echoview modules  

This tutorial requires a license with the Echoview Essentials module. If you do not yet have access to an 
Echoview license with this module, please contact sales@echoview.com to request an evaluation license. 

Contacting Echoview  

For assistance with this tutorial please contact support@echoview.com. 

Troubleshooting 

The files for a tutorial are typically located in C:\Echoview Software\Tutorials\. The file path may be different if 
you chose to install the tutorials elsewhere on your system. If the files are not in this folder, use Windows 
Explorer to search for them. If they are not loaded on your machine, download and reinstall the tutorial from 
www.echoview.com or from the Echoview USB drive. 

If you receive a message saying that the version of Echoview you are running cannot read the file you have 
opened, you may be running an old version of Echoview. You can download the latest version of Echoview 
from www.echoview.com.  

 
  

https://www.echoview.com/technical-support
mailto:sales@echoview.com
mailto:support@echoview.com
http://www.echoview.com/
http://www.echoview.com/
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Topic 1: Understanding Echograms 

 

In this topic you will learn:  

• about the main features of the echogram window, and 

• how to use the basic features of the echogram window to view data. 

Overview of echograms 

An echogram is a pictorial representation of the water column recorded by an echosounder. Data from each 
ping of the echosounder are represented by vertical columns on the echogram and multiple pings are 
displayed in time sequence. The colors within each column vary according to the value of each data sample 
within the column. A standard echogram presents volume or point backscatter data, but other variables can 
also be presented as echograms. 

Working with echograms 

In Echoview, the echogram window is the principal window used to display data for quality control, echo 
integration and analysis of backscattering strength and other data. 

1. Start Echoview by selecting it from the Start menu or by double-clicking the Echoview shortcut on the 
desktop. 

2. On the Welcome screen, click Open an EV file. 

3. Browse to GettingStarted_Topic1.EV, click Open. Echoview displays an echogram window like the 

one shown in Figure 1.  

 

Figure 1.  Echoview displaying an echogram from the GettingStarted_Topic1.EV file. The Details and Message dialog 
boxes are also displayed. 
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Data values 

Echoview provides key information about the data point (sample) at which the mouse pointer is pointed on the: 

• Tool bar (at the top of the main window) 

 

Figure 2. Information toolbar showing ping number (679), sample depth (190.26 m) and sample value (-43.53 dB) for the 
sample beneath the mouse pointer, and the color display minimum value (-70.00 dB). 

• Status bar (at the bottom of the main window) 

 

Figure 3. Echoview status bar showing the name of the active line (Bottom depth); its depth/range (depth: 249.00 m) and 
status (Good) of the active line on the same ping as the selected sample; a Message reminder; the data file name 

(96082827.ELD); the coordinates (42o 15.463' S 145o 18.675 E) and date/time (28-Aug-96 04:49:41.1100) at which the 
ping was recorded. 

• Details dialog box on the left-hand side of the echogram. 

4. Move the mouse pointer over the echogram and observe the changes on the Information toolbar, the 
status bar, and the Details dialog box. The information displayed in these areas is updated for each data 
sample over which the mouse pointer passes. 

Color scheme 

Echoview uses colors to represent data values. It includes many standard color schemes and allows you to 
create custom color schemes. 

To see which values a color represents you can check the Color Legend (on the right-hand side of the Sv 
pings echogram). 

This dialog box relates colors to sample values, e.g. samples with a value in the range -70 to -66 dB will be 
displayed with turquoise coloring. 

5. Click in the echogram window to activate it and then press and hold the – key (on the main keyboard, not 
the number pad) several times to reduce the Color display minimum value. The echogram and the Color 
Legend change as the Color display minimum setting is lowered. Samples with a value below the color 
display minimum value (-70 dB in the example above) are displayed in the color at the bottom of the Color 
Legend (white in the example above). Color display minimum is known as Display threshold in other 
applications. 

6. Press and hold the = key to increase the color display minimum to -70 dB 

7. Press Y. The color scheme changes to the alternate palette for the selected color scheme.  

8. Press Y again to toggle back to the primary color scheme. 

9. Right-click in the Color Legend. The color legend shortcut menu opens. You can change the color 
scheme, toggle the alternate color scheme and change the display settings from this menu. 

 

Tips 

• There are many shortcut key combinations in Echoview that can make data processing more efficient. 
Refer to the Echoview help file for a full list of shortcuts as well as instructions on how to customize 
shortcuts: 

o About keyboard shortcuts 

o Echogram keyboard shortcuts 

o User-defined keyboard shortcuts 

• If a menu item has a shortcut it will be shown to the right of the item:   
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Navigating 

Zooming 

Echoview provides a variety of zooming tools that allow you to view data in more or less detail. You can zoom 
on echograms using the mouse wheel, the zoom toolbar, zoom commands on the Shortcut (right-click) menu 
or keyboard shortcuts. 

1. Click the Rectangle tool on the toolbar. 

2. Click and drag on the echogram to form a rectangular selection similar to the one shown below. 

 

Figure 4. Echogram showing rectangular selection. 

3.  On the Shortcut menu (right-click), click Zoom In. 

 

Figure 5. Echogram after zooming in. 

4. Repeat steps 2 and 3 to zoom-in further. 
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5. On the Shortcut menu (right-click), click Zoom Out to zoom out one zoom level. 

6. On the Shortcut menu (right-click), click Unzoom to zoom out to the minimum zoom level. 

7. Use the center mouse wheel to zoom in and out. 

8. Hold down the CTRL key and use the mouse wheel to zoom out beyond a 1:1 ping to pixel ratio. 

Scrolling 

Vertical and horizontal scroll bars can be used to move around the echogram. 

1. Use the rectangle selection tool to create a selection and zoom in on part of the echogram. 

2. Use the horizontal and vertical scroll bars to move around the echogram. 

3. Resize the echogram window to see more or less of the echogram in the horizontal (time) dimension. In 
the vertical dimension (depth), the echogram is dynamically scaled to fit the window. 

 

 

Further information 

• Echoview installs a file called Echoview shortcuts.cfg that specifies some of the default keyboard 

shortcuts that Echoview uses. This file can be modified to specify user-defined keyboard shortcuts. For 
more information, refer to the Echoview help file topic - User-defined keyboard shortcuts. 

• Some Echoview actions are available to the Undo or Redo features. 

• You can flip the echogram so that depth or range reads from the bottom-up via a setting on the Display 
page of the Variable Properties dialog box. 

 

 

Before moving onto the next topic, you should close the EV file without saving changes. 

1. On the File menu, click Close. 

2. Click No when prompted to save changes to the EV file. 
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Topic 2: Understanding Cruise Tracks 

 

In this topic you will learn how to: 

• display a cruise track 

• display a map 

• navigate around the Cruise Track window. 

Overview of cruise tracks 

A cruise track is a graphic representation of a connected series of GPS fixes collected at the same time as the 
ping data. 

Working with cruise tracks 

1. On the Welcome Screen, click Open an EV file. Browse to GettingStarted_Topic1.EV, click Open. 

2. On the View menu, select Cruise Track, position GPS fixes. The Fileset 1: position GPS fixes window 
becomes the active window. 

3. Close the Sv pings and Filesets windows. 

 

 

 

Figure 6. The Cruise Track window. 

 

Loading maps 

Echoview allows you to load map files into the Cruise Track window.  

4. On the View menu, click EV File Properties (or press F6). 

5. Click the Mapping tab. 
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Figure 7. Mapping page of the EV File Properties dialog box 

6. Scroll down to the Map and waypoint files section. Click Add. The Add Map File dialog box is displayed. 

7. Select the file tasmania2pts.MIF. Click Open. 

8. Click OK. 

9. Zoom out in the cruise track window. A map of Tasmania and the cruise track are displayed. This has 
changed the scale of the Cruise Track window and the cruise track may be hard to see. However, if you 
look closely, you can see the cruise track in the Macquarie Harbour area. 
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Figure 8. Cruise Track window showing the map of Tasmania. 

10. Make a selection over the Macquarie Harbour area (as shown above) by clicking the mouse and dragging. 

11. Use the mouse wheel or the Zoom In tool  to zoom in. The horizontal and vertical scroll bars are now 
displayed. 

 

 

 

Figure 9. Map zoomed into Macquarie Harbour with a selection made over the cruise track area.  

 

12. Make a selection around the cruise track and zoom in further. 
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 Figure 10. Map of Tasmania with the cruise track area enlarged. 
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Synchronizing echograms with a cruise track 

Echoview allows you to synchronize echograms with a cruise track. 

13. On the View menu, select Echogram, Sv pings. 

14. Arrange the echogram and the cruise track so that they are displayed side by side. Point to the end of the 
cruise track (the black circle). 

15. From the Shortcut (right-click) menu, click Synchronize. The data logged at the end of the cruise track is 
displayed in the Echogram window. 

16. Point to the start of the cruise track (the black square) on the Cruise Track window. 

17. From the Shortcut (right-click) menu, click Synchronize. The data logged at the start of the cruise track is 
displayed in the Echogram window. 

 

Further information 

• The Vertical band tool enables you to make a selection on a cruise track and define regions. For more 
information, refer to the Echoview help file topic “Using cruise tracks – Define a region”. 

To remove a map file from your EV File: 

1. Open the EV File Properties dialog box (F6). 

2. Click the Mapping page. 

3. Select the map and click Remove. 

To keep a map file in your EV File, but remove it from view in the Cruise Track window: 

1. Ensure the Cruise Track window is selected. 

2. Open the Variable Properties dialog box (F8). 

3. Click the Cruise Track Display page. 

4. Clear the map in the Map display section. 

• Echoview can use WMS maps in cruise track windows to provide context.  

• An alternative GPS processing method (to account for early bad fixes) is available on the Data page of the 
cruise track Variable Properties dialog box. 

• The Echoview status bar displays the Cartesian co-ordinate calculated area of a rectangular or polygon 
selection made in a Cruise Track window. Refer to the Echoview help file “Using cruise tracks” for more 
information. 

• Echoview supports ESRI shapes. 
 

 

Before moving onto the next topic, you should close the EV file without saving changes. 

1. On the File menu, click Close. 

2. Click No when prompted to save changes to the EV file. 



 

Echoview Tutorial: Getting Started Page 13 of 29 

Topic 3: Files and Filesets 

 

In this topic you will learn: 

• about the Filesets window 

• how to load data files into Echoview 

• what an EV file is  

• how to use EV files to manage your data. 

 

 

Working with data files and filesets 

Definitions 

You need to understand the following terms to continue with this topic: 
 

Term Definition 

Data file Files of data logged from echosounders and other equipment. Data files are 
usually primary information archived from a survey. 

Note: Data files are never modified by Echoview. 

Variable An Echoview "variable" is a time-series of measurements of one data type. An 
acoustic variable, where the data is made up of pings, can be displayed as an 
echogram. A position variable, where the data is made up of GPS fixes, can be 
displayed as a cruise track. Other variable types are also possible. 

Fileset A set of data file(s) and the variable(s) derived from those data file(s). 

 

 

The Filesets window 

The Filesets window is used to manage filesets, data files and variables. It can contain a single fileset or 
multiple filesets. Each fileset will be displayed on a separate tabbed page. 

Open GettingStarted_Topic4.EV. 

1. On the View menu select Filesets. The Filesets window is displayed. This window has three distinct 
sections: the Data Files section at the top, a Calibration file section in the middle and Raw Variables at the 
bottom. 
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Figure 11. The Filesets window. 

 

Data Files section 

The Data Files section of the Fileset window displays the name and folder of the data file(s) that have been 
added to the current fileset as well as the time of the earliest and latest ping in each data file. 

Calibration file section 

The Calibration file section of the Filesets window displays the calibration file used for the fileset, if selected. 
Buttons enable you to browse to add, remove or edit a calibration file. 

Raw Variables section 

The Raw Variables section of the Filesets window displays information on the variables (telegrams/tuples and 
other measurements) that Echoview has derived from the data file(s). Raw variables may be viewed in several 
ways - this is achieved through context-sensitive buttons. The Properties button for a variable is always 
available. 

The Data Files section in this EV file contains two data files and the Raw Variables section contains three 
variables (Sv pings, position GPS fixes and a sounder-detected bottom line). Echoview allows you to add 
multiple data files of the same type to a fileset (e.g. multiple data files from the same survey) and when it 
detects common data types in these files (e.g. a common telegram) it derives a single raw variable that 
incorporates measurements from these files. This allows you to view data that was logged in multiple data files 
as a single echogram and to analyze data in multiple data files by analyzing a single variable. 

Tips  

• For further information about the Filesets window refer to the Echoview help file: 

o About the Filesets window. 

o Filesets window shortcuts. 

• The shortcut for the Filesets window is F10. 

• You can copy data file paths from the Filesets window. 

• Problems in data files are flagged when they are first added to the Filesets window. Flags appear as 
messages in the Messages dialog box. 

• Echoview supports data files of any size. 

• You can use Echoexplore to find and catalog compatible echosounder and sonar data files on your 
computer. You can download Echoexplore from the Echoview website. 
 

https://www.echoview.com/products-services/echoexplore
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Working with EV files 

Echoview uses EV files to organize data files and filesets. You might create a single EV file containing all the 
data for a complete survey, an EV file for each transect of a survey, or an EV file for each day of a survey. 

Creating an EV file 

1. On the File menu, click New. If the New EV File dialog box is displayed, click No Template. The Dataflow 
and Filesets windows are displayed. 

Adding data files to an EV file 

2. Click Add in the Filesets window. The Add Data files dialog box is displayed. 

3. Select the data file DemoData.ek5. Click Open. The DemoData.ek5 file is displayed in the Data Files 

section of the Filesets window. This data file contains 14 raw variables that are listed in the Raw 
Variables section as shown.  

You could add other .ek5 files to this fileset (e.g. data files from earlier or later in the same survey) and 
Echoview would add the pings from those files to existing variables. This allows you to view a continuous 
echogram rather than separate echograms for each data file.  

 

 

Figure 12. Filesets window with the Demodata.ek5 data file added. 

 

Displaying the echogram of a variable 

4. In the Raw variables section, click Sv Q1 telegrams T1. 

5. Click Echogram. The echogram of Sv Q1 telegrams T1 variable is displayed. 
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Figure 13. Echogram of the Sv Q1 telegrams T1 variable 

6. In the Raw variables section, click Sv Q2 telegrams T2. 

7. Click Echogram. Echoview displays the echograms for the Sv Q1 telegrams T1 and Sv Q2 telegrams 
T2 variables simultaneously. 

Saving an EV file 

8. On the File menu, click Save As. The Save As dialog box is displayed. 

9. Select the folder in which the tutorial data have been saved. 

10. In the Filename box, type GettingStarted_Topic3. Echoview adds the .EV file extension 

automatically when you save the file. 

11. Click Save. 

Saving your workspace 

Your workspace “remembers” the windows that are displayed in Echoview, together with their positions and 
contents. Echoview can save this workspace so that when you open this EV file again, you find it the way you 
left it. 

12. Adjust the borders between the windows that you have open. 

13. Zoom into a part of the Sv echogram 

14. On the File menu, click Close. 

15. On the File menu, click Exit. 

16. On the Welcome Screen, under Recent files click on the EV file name. Echoview opens the EV file, and 
displays the window as you left it. 

17. On the View menu, click EV File Properties. 

18. Click the EV File tab. Under Workspace look at the When EV file is opened list. You can configure the 
Echoview workspace behavior. Press F1 for Help. The workspace is saved in the same folder as your EV 
file, in a file of the same name with the .evwx extension.  

19. You may close the EV file. 
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Topic 4: Bottoms and Lines  

In this topic you will learn about sounder-detected bottoms (which are categorized as raw lines), editable lines 
and virtual lines. 

Working with sounder-detected bottom lines 

Overview of sounder-detected bottom lines 

Echoview can derive the (recorded) sounder-detected bottom from most data files and displays it as a line on 
an echogram. 

1. Open the GettingStarted_Topic4.EV file. 

2. Display the Sv pings echogram. 

3. Click the echogram and on the Shortcut menu (right-click) select Variable Properties. 

4. Click the Lines page. 

5. Click Fileset1: line data sounder-detected bottom. 

6. Click OK. The sounder-detected bottom line is displayed as a yellow line running above the dense 
green/blue bottom area on the echogram. A close look at the yellow line in this EV file will reveal that the 
sounder-detected bottom is not accurate (you may have to scroll to the right depending on the display 
settings on your PC). In this example, the sounder-detected bottom line has jumped from the bottom echo 
to the second bottom echo. 

 

Figure 14: The yellow sounder-detected bottom line on the Sv pings echogram. 

Changing line display thickness and color 

Echoview allows you to specify a custom line thickness and line status color for a line variable. 

7. Click on the sounder-detected bottom line and on the Shortcut menu (right-click) select Line Properties. 

8. Click the Display page. 

9. Select Custom. 

10. Use the up or down arrow to change the line thickness. 

11. Click on the color panels to change the default line status colors. 

12. Click OK. The line is now displayed in your chosen thickness and color. 
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Working with editable lines 

Overview of editable lines 

Echoview allows you to create any number of editable lines and each line can be given a name. You can 
create editable lines in a number of ways, including: 

• hand drawing the line 

• specifying a fixed depth 

• using a line pick algorithm to detect the seafloor 

• applying an offset (linear or angle offset) to an existing line. 

You can use the Line and Surface tool   or open the Dataflow window  to create new editable 
lines.  

Creating lines using a line pick algorithm 

You will practice creating lines using a line-pick algorithm and specifying a fixed depth in this topic. Refer to 
the help file for information about creating lines using the other methods. 

In this exercise, you will create a new line using the default line pick algorithm. This algorithm is tuned for echo 
integration and will create a line that is just above the bottom echo. 

13. On the Echogram tools toolbar, click the Line and Surface tool list , and then click New 

Editable Line. Alternatively, click Dataflow  to open the Dataflow window.  Click Fileset1: SV pings 
to select it, then on the Shortcut menu (right-click), point to New, and click Editable Line. The New 
Editable Line dialog box is displayed. 

 

Figure 15: The New Editable Line dialog box. 

14. In the Create a new line box, type: New Bottom. You could name the line anything you wanted. 

15. Under Source, click Pick from current variable. 
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16. Select Span gaps. 

17. Click OK. The new editable line is displayed as a green line on the echogram. 

 

Figure 16: The active New Bottom line as a running line. 

Creating fixed-depth lines 

Lines can also be created with a fixed depth. In this example, you will create a fixed-depth line that could be 
used to exclude transducer ring-down from the echo integration area. 

18. Click the Rectangle tool  on the toolbar. 

19. Make a rectangular selection at the top of the echogram that includes the surface area (as shown below). 

20. Zoom in on the selection. 

21. Adjust the Color display minimum until it is –79dB. The echogram should appear similar to the example 
below. 

 

Figure 17: Echogram showing high sample values (the blue-gray band) in the first 2 meters. 

22. Point to the bottom of the blue-gray band at the top of the echogram. The depth displayed in the tool bar 
shows approximately two meters. You now know the required depth of the fixed-depth line that you will 
create. 

23. On the Echogram tools toolbar, click the Line and Surface tool list  and then click New 

Editable Line. Alternatively, click Dataflow  to open the Dataflow window, then on the Shortcut menu 
(right-click), point to New, and click Editable Line. 

24. Under Destination, click Create a new line. 
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25. In the Create a new line box, type: Fixed-depth line. 

26. Under Source, click the Fixed depth option. 

27. In the Fixed depth box, type: 2.5. 

28. Click OK. The fixed-depth line is displayed on the echogram. 

 

Figure 18: Echogram showing fixed-depth line at 2.5 meters. 

Choosing which lines are visible on an echogram 

Lines are stored in the EV file and are displayed by default on only the active echogram. You can however 
select which lines to display on each echogram. 

29. On the Echogram menu, click Variable Properties. The Variable Properties dialog box is displayed. 

30. Click the Lines tab. 

 

Figure 19: Lines page of the Variable Properties dialog box showing visible and active line.  
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31. Clear the sounder-detected bottom option. 

32. Click OK. The sounder-detected bottom line is no longer displayed on the echogram. You may need to 
zoom out to confirm this. 

 

Editing lines 

You can manually edit editable lines (but not sounder-detected bottoms - they are read from the data file and 
cannot be changed). 

33. Make a selection on the echogram at the location shown below. 

 

Figure 19: Echogram showing selection to be zoomed. 

34. Zoom in to see more detail. 

 

Figure 20: Echogram zoomed in over selection. 

35. Click the Line and Surface tool. 

36. On the drop down list, click New Bottom. New Bottom is selected as the active line to which edits will be 
applied. 
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Figure 21: Echoview toolbar with New Bottom, Line and Surface tool selected. 

37. Progressively click from left to right (or click and drag) over the object that appears to be just above the 
bottom. Note: Line edits can be finer than single pings and single-sample depths. 

 

Figure 22: Echogram showing line drawing over bottom object. 

38. On the Shortcut (right-click) menu, click Update Active Line. The line is redrawn over the object as 
shown below. 

 

Figure 23: Echogram showing the redrawn line. 
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Working with virtual lines 

Overview of virtual lines 

In addition to editable lines and raw lines, Echoview supports a category of lines known as virtual lines. 

Virtual lines are lines that are defined relative to a line, another virtual line, or a raw line. The relationship 
between a virtual line and the line on which it is based is dynamic, that is, if you change the reference line the 
virtual line will be updated automatically. For example, if you had defined a virtual line based on the New 
Bottom line you created in an earlier exercise, the virtual line would have been redrawn automatically when 
you edited the bottom line. 

Creating virtual lines 

In this example you will create a virtual line that is offset by -10 meters from the New Bottom line. 

39. On the Shortcut (right-click) menu, click Unzoom. 

40. On the Echogram tools toolbar, click the Line and Surface tool list , then click New Virtual 

Line. Alternatively, click Dataflow  to open the Dataflow window, then on the Shortcut menu (right-
click), point to New, and click Virtual Line. 

41. From the Operator list, select Linear offset. 

42. In the Name box, type: New bottom minus 10 meters. 

43. Click OK. The Line Properties dialog box is displayed. 

  

Figure 24: Line Properties dialog box. 
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44. Click the Operands page. 

45. In the Operand 1 list select New Bottom. 

46. Click the Linear Offset page. 

47. In the Multiply depth by box, type: 1. 

48. In the Then add box, type: -10. 

49. Click OK. The virtual line is displayed as a green line with a dashed pattern and appears 10 meters above 
the New Bottom line.  

 

Figure 25: An echogram displaying a virtual line 10 m above the acoustic bottom line. 

Try editing the New bottom line again and observe that the virtual line is automatically updated. 

 

Further information 

• Raw lines include sounder-detected bottom lines and line data read from data files. Raw lines can 
represent depths from a sensor (trawl or other types of depth information) or heave. Raw lines can’t be 
edited but you can create editable lines based on raw lines. 

• Operators create virtual lines. There are virtual line operators that are equivalent to editable line types and 
line manipulation operators that can crop, combine or filter lines. 

• There are several line pick algorithms available. The line pick algorithm is specified under (F6) EV File 
Properties: Lines and Surfaces. A line pick is started using Pick New Line from the (right click) 
Shortcut menu.  

• The color and thickness of any line can be customized in the Line Properties dialog box. 

• For more information about lines, line settings and line uses refer to the Echoview help file: About lines. 

 

 

Before moving onto the next topic, you should close GettingStarted_Topic4.EV file.  

It is recommended that you save the file with a different name (using Save As) so you can repeat this topic at 
a future date if required. 
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Topic 5: Selections and Regions 

 

In this topic you will learn how to make selections and create and edit regions. 

Overview of selections and regions 

Selections and regions are subsets of an echogram and can be used for some or all of the following: 

• to place visual markers on an echogram. 

• for on-screen analyses. 

• to select data for inclusion or exclusion from on-screen and export analyses. 

Note: This topic does not cover the uses to which selections and regions can be put. For more information 
about how they can be used, refer to other tutorials and the help file. 

Working with selections 

Selections can be used for on-screen analyses, to define regions, to select the single targets to include in a 
fish track, etc. Echoview provides multiple selection tools to ensure you can make selections quickly and 
accurately. 

1. Open the GettingStarted_Topic4.EV file. 

2. Display the Sv pings echogram. 

Making selections using the Rectangle tool 

The first tool on the tool bar that you can use to make a selection is the Rectangle tool . You have used 
this tool in previous topics to define areas to zoom-in on. The rectangle tool allows you to make a rectangular 
selection on the visible portion of an echogram. 

Making selections using the Horizontal band tool and Vertical band tool 

The Horizontal band tool  and Vertical band tool  allow you to make rectangular selections that 
span the entire horizontal and vertical dimensions of the echogram respectively. 

3. Click in the Echogram window. 

4. Click the Horizontal band tool. 

5. Move the mouse pointer to a depth of approximately 200 meters on any ping on the echogram. The depth 
of the sample at which the mouse pointer is pointing is displayed in the tool bar. 

6. Click and drag the cursor to depth of approximately 250 meters. 

7. Release the mouse button. A horizontal selection is created between the depths of 200 meters and 250 
meters. 

 

Figure 26: A horizontal selection on an echogram. 
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8. Use the horizontal scroll bar to scroll to the right. You will notice that the selection spans the entire 
echogram. 

The Vertical band tool works in a similar way but defines a selection in the vertical dimension. You can 
practice using this tool now if you wish. 

Making selections using the Parallelogram tool 

The Parallelogram tool  allows you to make selections that are not perfectly vertical or horizontal, e.g. a 
selection that follows the bottom or a fish track. 

In the following example, you will create a selection with a thickness of 15 meters that follows the bottom of 
the echogram.  

Note: You will use approximate values for the purpose of this exercise but could create a more accurate 
selection using the same techniques. 

9. Use the horizontal scroll bar to display the far left of the echogram. 

10. Click the Parallelogram tool. 

11. Move the mouse pointer to a depth of 330 meters at the far left of the echogram. 

12. Click and drag until the mouse pointer is just above the bottom line (approximately 300 meters) then 
release the mouse button. Note: This sets the thickness (height) of the parallelogram. This thickness will 
be used for the entire selection. 

13. Move the mouse pointer to the point just above the bottom where the gradient of the bottom first changes 
slightly (at the time reference of approximately 4:42:00). 

14. Click just above the bottom at this point. The first section of the parallelogram selection is drawn. 

 

Figure 27: The first part of the parallelogram selection is shown. 

15. Position the mouse pointer so it is just above the bottom at the point where the gradient of the bottom 
changes again (for the purpose of this exercise use the time reference of 4:50:00). 

16. Click left mouse button. The second section of the parallelogram selection is drawn. 

 

Figure 28: The second part of the parallelogram selection is now shown. 

17. Position the mouse pointer so it is just above the bottom of the echogram at the right most point that is 
currently displayed in the echogram window. 

18. Click the left mouse button. Another section of the parallelogram selection is drawn.  
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Note: You could scroll across and continue the selection. You can do this now if you wish. 

Making selections using the Polygon tool 

The Polygon tool  allows you to make selections of any almost shape using a free-hand drawing tool. 

19. Click the Polygon tool. 

20. Click and drag to create a shape of your choosing (e.g. draw a selection around a school. When you are 
ready to close the polygon, drag the mouse pointer back over your starting point. Then on the right-click 
menu select Define Region. Note: You can draw and close polygons using other techniques that are 
described in the help file. 

 

Figure 29: An echogram showing a polygon selection. 

Tips  

• Echogram windows remember their active tools. 

Working with regions 

Overview of regions 

Regions are like permanent selections and can be used for many purposes in Echoview, including: 

• placing visual markers on an echogram 

• on-screen analysis  

• identifying part(s) of an echogram to include in analyses 

• identifying part(s) of an echogram to exclude from analyses 

• defining fish tracks 

• defining schools. 

Echograms can be synchronized to the active region. On-screen analysis results can be linked to an active 
region. 

Region types 

Echoview has five region types: 

Region type Description 

Analysis A part of an echogram that you can analyze separately from other parts of the 
echogram. 

Bad data (no 
data) 

A part of an echogram that is unwanted and which can be handled in a specific way in 
analyses.  



 

Echoview Tutorial: Getting Started Page 28 of 29 

Bad data 
(empty 
water) 

A part of an echogram that is unwanted and which can be handled in a specific way in 
analyses. 

Marker A part of an echogram that is of interest and should be visible on an echogram, but is 
neither bad data nor data that needs to be analyzed separately from other parts of the 
echogram. 

Fish track A selection of closely associated single targets that are assumed to have to have been 
generated by one fish. 

Note: Fish-track regions are a special class of region and some of the 
information/procedures described in this topic do not apply. Fish-track regions are 
covered in more detail in the "Introduction to Fish Tracking" tutorial. 

 

 

Note: Region type is one level of classification only. Echoview also allows you to create region classes. 

Creating regions 

You create regions from selections.  

In this exercise you will create an analysis region using the rectangle tool. 

21. Click the Rectangle tool  on the toolbar. 

22. Make a selection around an area of interest on the echogram. 

23. From the Shortcut (right-click) menu, click Define Region. The region is defined and the Region Browser 
dialog box is displayed. 

 

Figure 30: A region is displayed on the echogram and the Region Browser dialog box is displayed. 

24. Under Name, type the region name: Test region. 

25. Under the Type list, select Analysis. 
The region name and type has changed. The shading on the echogram has changed from purple to 
yellow. Echoview assigns a different color to each region type so you can quickly identify region types 
while you are working on an echogram. 
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Figure 31: The region name and region type have changed on both the Region Browser dialog box and on the echogram. 

26. Close the Region Browser dialog box.  

Editing regions 

Once you have created a region you can change its properties (e.g. name and type) and shape (i.e. samples 
included in a region) at any time. 

You can change the properties of a region using the Region Browser dialog box. To display the Region 

Browser dialog box, select the region and click the Region Browser tool ,. This may require using the 

More buttons tool  first. 

Echoview allows you to change the shape of a region in three ways using the Region edit tool : 

• by moving the nodes (anchor points) of the region 

• by redrawing parts of the region boundary 

• by nudging (creating indentations in) the region boundary. 

If you would like to practice any of these techniques, see the "Editing regions" topic in the help file. 

If you are going to complete another tutorial or practice what you learned in this tutorial you can close the EV 
file and leave Echoview running, otherwise close Echoview. 

 

Tips  

• Region properties include a Notes page where you can input text in your own language. 

• You can export a ‘log book’ of regions (including their notes and locations) to a csv file by opening the 
Echogram menu and selecting Export then Regions then Log Book. 
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